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Copyright 

This document is protected by the intellectual property rights of CAD Projekt K&A. Copying, distribution and / or modification of the following document is allowed under the terms of the license agreement. The 

license agreement is available in electronic form upon program installation. 

Limitation of liability 

Information in this document, including URL and other Internet Web site references, is subject to change without notice. CAD Projekt K&A reserves the right to 

introduce changes to the rules of technical support without prior notice. If it is necessary to change telephone numbers, relevant information will be provided on our website www.cadprojekt.com.pl.  

INTRODUCTION  

 

This manual explains how to begin using CAD Decor PRO, CAD Kitchens, and CAD Decor 64-bit versions. It covers entering 

registration codes, managing projects, program settings, creating new projects, and using CAD environment tools. Additionally, it 

provides a list of icon menu functions and useful keyboard shortcuts. This section discusses tools based on IntelliCAD version 10.1. 

It is important to note that there may be differences in the operation of the described functions for earlier versions of the 

environment, which will be indicated in the manual. 

We hope you enjoy working with our software! 

CAD Project K&A team 
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1.  Programme initiation   

There are three ways to run the program: 

• by selecting CAD Decor PRO, CAD Kitchens or CAD Decor icon from the menu Start (Illustration 1), 

•  by double-clicking the program shortcut icon on the desktop(Illustration 2, 

Illustration 3, Illustration 4)  

• By running the CADDecorPro.exe, CADKuchnie.exe or CADDecor.exe file in the V4_I10x64 

directory in the program installation location. Example location :C:\CADProjekt\CAD Decor 

PRO\ V4_I10x64. 

In order to run the program, the HASP security key must be plugged into the computer's USB 

port. Otherwise time a message will appear (Illustration 5), and the program will not run.  

   

If the HASP key LED does not light up, try plugging it into a different USB port or swapping it with another device. If the issue persists, 

please contact our Technical Support immediately. Contact information can be found at the end of this manual. 

 

 

 
 

 

Upon launching the program, a welcome screen (Illustration 6, 7 and 8) will appear. If it is the first time starting up, a window will prompt 

you to enter the registration codes (Illustration 9). For subsequent launches, the 'Design Selection' window will open, which is described in detail 

in the following section. 

Illustration 1 Starting the program from the Start menu level 

Illustration 2  Decor PRO program icon Illustration 3 Decor  program icon Illustration 4 Kitchen program icon 

Illustration 5  Message about missing HASP key 

Illustration 6  CAD Kitchen Program Welcome Screen 

Illustration 7 CAD Decor Program Welcome Screen 

Illustration 8 CAD Decor  PRO Program Welcome Screen 
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To access the program codes, open the program and select the Help tab. To access the program codes, open the program and select 

the Help tab. Then, choose the Activation Codes option (Illustration 10) to enter any additional module codes. 

2. "Design Selection" window (project manager)  

2.1. General information 

This is the first element that appears when you start the program. It is used to create new projects and open existing ones. When you 

run the program for the first time, this window displays sample demo projects. The procedure for creating a new project is described in Section 3.  

To open an existing project, point to its position in the project list (in the "List" view) or preview (in the "Icons" view). Then click the 

"Open Project" button in the lower right corner or select this option from the pop-up menu under the right mouse button (Illustration 12). You 

can also open the project by double-clicking with the left mouse button. 

NOTE 

You do not need to complete the codes for additional modules to start working with the program; you can complete them later. 

 

Illustration 9 License Manager window for completing activation codes(Cad Kitchen) 

Illustration 10  Help tab in the top menu -Activation Codes 
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The appearance of the project manager window can be customized to your preference by changing its size and the way projects are 

displayed, using the view options(Illustration 11). Two views are available: iconic (thumbnail previews) (Illustration 11) and tabular (list with project 

data) (Illustration 12). You can also enable a group view, in which projects are grouped according to the directories in which they are saved 

(Illustration 13).  The view settings are remembered the next time you start the program. 

The list in the project manager window shows projects saved in the working directory, i.e. a user-defined folder for storing finished 

projects. By default, this is the "Projects" folder in the program directory (example: C:C:Decor PRO v. 4.0.2). To open a project from another 

location, select the "Browse" or "Import" button (more in section 3.1). 

Illustration 13 Window Design Selection: In the group view, there is a visible division of catalogues that can be collapsed or expanded using arrows. 

Illustration 11 Window "Design selection". - Icon view, visible functions to manage view Illustration 12 Window "Design selection". – List view, with open pop-up menu under the right 

mouse button 
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2.2. Features of the Design selection window 

There are two menus in the project selection window - the top menu (Illustration 16) and the pop-up menu (Illustration 17 and 

Illustration 18). The options contained in them are described below. 

 

 

 

 

 

 

NOTE  

In CAD Kitchens and CAD Decor PRO, the manager projects pop-up menu includes the option to 'Open design with base', which is 

not available in CAD Decor due to the lack of functions for managing kitchen cabinets and their bases.   It is used when a user 

selects the wrong base and needs to assign a different one. If the project already has cabinets inserted from the previous base, 

they will be retained. Please note that if items from multiple kitchen bases are present in the project, there may be consequences. 

For instance, replacing sets will only work within the current base. Additionally, in the quotation and documentation, the names 

of cabinets from the previously used base may not be displayed. 

Illustration 16  Top menu of the Design selection window 

Illustration 17 Pop-up menu of thea design selection windowin the CAD Decor software. Illustration 18  Pop-up menu of the design selection window in the CAD 

Decor PRO and CAD Kitchens programs. 

Illustration 14 Project preview in window manager. Illustration 15 Deleting selected projects 
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„New design” 
The first function of the top menu is also available from the pop-up menu. It opens a window containing the 

data for the new project. Once this data has been completed, work on the new project can begin. 

„Browse” 
You can edit a project saved in a location other than the working directory using the function available from the 

top menu and pop-up menu. 

„Import” 
Option is available from the top menu and the pop-up menu.  This option allows you to open a project from a 

location other than the working directory and simultaneously copy it to the working directory. 

„Preview” 
Button in the top menu and option in the pop-up menu. Activates when you click on a project item in the list (in 

table view) or its thumbnail (in icon view). Displays its preview (Illustration 14).  

„Options” 
Button in the top menu. Opens a window where you can manage project catalogs and autosave options, as 

well as change studio data. Further information can be found in the sections.3.2,3.3 i3.5). 

„Filter” 

Top menu option. Opens a window where you can search for projects 

according to the set criteria (Illustration 19). Choices include name, 

number, date created, modified or last accessed, path or size of the 

project, designer's name, client's last name or first name. Dates can be 

selected from the calendar, expanding when you click the button next 

to the date.. After completing the search data and clicking "Search", the 

relevant orders will be displayed in the project selection window. To 

start the search from the beginning, click "Reset" and enter the search 

data again. 

 

„Recovering” 

The 'Recovering” button can be found on the top menu. It allows users 

to retrieve any unsaved information in case of a system failure. A 

window opens with a list of projects that have been saved due to 

autosave. The recovery procedure is described in section 3.4.  

"Delete” 

The function is accessible from both the top menu and the pop-up menu. It allows the removal of selected 

projects from the list and the computer disk.. To delete projects or a directory with projects (which is possible in 

the group view (Illustration 15), select the relevant element with the left mouse button, select "Delete" from 

the top or pop-up menu  and confirm the operation. The Projects will disappear from the list in the project 

manager window and from to today’s location on the computer disk (they will be moved to the trash).  

Note that deleting an entire directory will remove it from the list in the manager window, but it will remain in 

its original location on the disk. Only the projects within the directory will be moved to the trash. 

Illustration 19 ,, Filter" window 
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„View” 

The top menu button enables you to switch between tabular and 

iconic views, as well as to enable group view (with a breakdown by 

directory of record) and refresh view.  

„Open a design” 

Pop-up menu option. Also available in the lower right corner of the 

manager projects window and under a right-click double-click. Opens 

the indicated project. 

„Open a design with 

base” 

This option is available from the pop-up menu in CAD Kitchens and 

CAD Decor PRO. Causes the opening of the project with simultaneous 

invocation of the kitchen furniture base selection window (Illustration 

21). This allows you to change the kitchen furniture base selected in 

the project to a different one. 

„Export design(s)" Creates a ZIP archive containing the designated project or projects and allows you to save it to any location. 

 

 

The following sections describe procedures for creating new projects, opening or importing projects from locations outside of the 

working directory, defining project save directories, and other functions of the project selection window. Subsequent sections provide useful 

information to help you become familiar with the program. 

  

Illustration 20  View control options 

Illustration 21 Kitchen base options 
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3. Creating a new project 

Creating a new project begins by selecting the "New design" option available on the top bar and in the pop-up menu of the project 

manager. In the newly opened window (Illustration 22), fill in the necessary data. Required items are in bold.  

In the "Working folder" field, you can define a folder for saving completed projects by indicating the path to it on disk - using the "Define 

folders" button (more on this in section 3.2).  If the working directory contains subdirectories, a list of them will be displayed when you expand the 

"Subdirectory name" field (Illustration 23). To create a new subdirectory in the working directory, enter its name here. Subdirectory names can 

be separated using the separator: . If this field is left blank, the current project will save directly to the working folder. 

The data of the designer should be provided in the fields "Designer name" and "Designer ID”. They are remembered by the program 

and will be displayed when it is restarted. They can be changed by typing a new one or selecting a previously added name from the drop-down 

list. If necessary, the designer's data can be deleted. To do this, select the "Delete designers" button, then select the item to be removed and click 

"Delete" (Illustration 24). 

 

After entering the project data, you can start working with it by clicking the "New" button in the lower right corner. You can also return 

to the project selection window without creating a new document by selecting "Cancel". 

NOTE 

Special characters such as (= ", : ; * < > / | ' ~ ̀  ?) cannot be used in the project name. 

Illustration 22 Window "New design details" 

Illustration 23  Management of designer data 
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3.1. Importing and Opening Existing Projects  

The "Browse" option allows you to open a project saved in a location other than the default project storage directory. Selecting it from 

the top bar or from the pop-up menu under the right mouse button opens the "Select a file" window (Illustration 25), where you search for the 

project and click "Open". Design will open, and when you save changes to it, they will be overwritten in the location from which it was opened.  

After selecting the "Import" button, the "Imported Project Data" window is launched (Illustration 26). In it, you should indicate the 

project to be imported by clicking on the button  and searching for its location. In CAD Kitchens and CAD Decor PRO, if the kitchen furniture 

base, on which the imported project was created Whereas the "Delete" option is not present in the program's directory, you can indicate any of 

your bases, which will henceforth be used when working with 

this project (Illustration 26). Then confirm the selection with the 

"Next" button. In the next step, you can change the name and 

other data of the imported project (Illustration 27), and then 

proceed to work with it by clicking "Finish”.  

  

Illustration 24 Selecta project do open a from a location other than and the working folder. 

Illustration 25 Importing a project into CAD Decor PRO and CAD Kitchen programs. 

Illustration 26 - Design indicated to be imported in CAD Kitchens or CAD Decor PRO 

programs 
Illustration 27 Design indicated to be  imported, program expects ask from confirmation in the 

CAD Decor program (no kitchen database for selection) 
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3.2. Defining storage directories for the project 

You can access the options for managing project save directories in two ways: by selecting the "Options" icon from the top menu or the 

"Define folders" button when creating a new project (Illustration 30). In either case, you will see the "Options" window open on the "Design 

Manager" tab (Illustration 31). It displays a list of project saving directories. When you click a directory item in the list, you can delete it using the 

"Delete" button (the item will be removed from the list, but the directory and the projects it contains will remain on the computer's disk). You can 

also add any text to its name - in the field under the directory list (to change the name, click the "Change" button). On the other hand, the "Delete 

incorrect" option deletes folders that are repeated or absent from the disk from the list. 

  

A new working directory can be added in two ways. The first option is to type the path to it in the field under the directory list 

(Illustration 32). At this point, the "Add" and "Modify" buttons are activated. The first allows you to add a new directory to the list of working 

directories, creating at the same time a new folder on disk (if a path to a directory that does not yet exist is given). The second allows you to rename 

a directory present in the list. If no existing folder is selected when you click the " Modify " button, the program will ask whether to create a new 

folder.  If approved, a new folder will be created in the specified location. If the location is incorrect, the program will inform you about it. 

The second method of adding a working directory to the list is to point to the appropriate folder on your computer's disk. To do this, 

select the "Browse" button (Illustration 33) - the "Browse for Folder" window will open, where you should search for a folder, select it and confirm 

the selection with the "OK"  button (Illustration 34). The name of the selected folder will appear in the list of "Designs catalogs To define the newly 

added folder as the default, double-click on it with the left mouse button or, after selecting it, select the "Set as Default" button (Illustration 34).  

Illustration 28 The next step of importing project - the ability to change the name and other data 

Illustration 29 New design details – define folders Illustration 30 To add a new directory, select go with the "Browse" button." 
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Buttons  and  on the right side of the "Options" window are used to set the order in which the folders with projects are displayed in 

the "New design details" window in the group view display mode (with a division into folders). 

4. Managing Autosave Options 

Automatic saving of changes protects against loss of unsaved information in case of design failure. By default, it runs every 15 minutes. 

This frequency can be changed at the bottom of the "Options" window (Illustration 35). At this point, you can also completely disable autosave in 

a project by unchecking the box "Auto-Save”.  

Illustration 33 List of designs storage catalogues and name of new folder entered in the field below the list 

Illustration 31 - Add the directory to the list of working directories. 

Illustration 32 New directory added to the list of directories for storing projects and the ability to set it as 

the default directory 

Illustration 34 Ability to set the frequency of autosave and deletion of project backups 
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It is recommended to use autosave as it allows you to recover your work in case of an unplanned program shutdown. This is because 

the last autosave state can be recovered using the 'Recovery' function, which is described in the next section.  

To change the autosave interval, click the "Options" icon in the project selection window, and then in the "Autosave" panel in the 

"Options" window, enter the appropriate numerical value by typing it from the keyboard or using the arrows. The maximum interval between 

autosaves is 240 minutes. The recommended interval is 5 minutes to avoid cumbersome work with the project when saving changes, as starting 

an autosave causes the program to pause momentarily. To confirm the settings, click "OK.”. 

4.1. Project recovery 

To recover unsaved project changes lost due to a crash, select the "Recover" button in the project selection window. This will open the 

"Design Recovery window (Illustration 37). In which, in the list of projects preserved thanks to autosave, indicate with a click the appropriate item 

(corresponding to the version of the project you want to recover), and then select one of two options: "Restore" or "Restore and Open". Both 

cause the project to be recovered in the state from the last autosave, the second one additionally opens it directly after approving the operation. 

Before opening, the program asks for the name of the recovered project. You can keep the default name (name_project_backup) or change it to 

a different one.  

 

4.2. Entering studio data 

To add or change design studio data, select the "Options" button in the design selection window, and then switch to the "Studio Details" 

tab (Illustration 38). To select a company logo, click the "Point to File" button and search for the appropriate JPG or BMP file on disk (Illustration 39). 

In the "Studio Data" panel, you can enter the company name and contact information (Illustration 40). The provided information and logo will be 

UWAGA  

The user can save changes to the project independently at any time by selecting the 'Save' icon from the icon menu in the .4CAD environment 

or using the [Ctrl + S] command on the keyboard, both when working in the CAD environment and in visualization. 

Illustration 36 Indicating the project backup to be recovered in the "Design Recovery" window 

Illustration 35 Renaming the recovered design 
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visible in programs (CAD Decor PRO and CAD Decor), in lists of tiles, grouts and paints, and the logo will also be visible on the title page of technical 

documentation. 

  

5. Appearance of the .4CAD environment window 

Upon creating or opening a project, the user will be directed to the dot4CAD environment (Illustration 41). For new projects, a wall 

wizard window will also appear, providing the option to select and customize any of the default room templates. The process for creating walls is 

outlined in a separate manual. The interface and functions of the .4CAD environment will be discussed below. 

UWAGA  

The studio's data can be specified or changed at later stages of the project. This can be done by calling the ,,Project information” function 

from the 'File' menu in the CAD environment. It is also possible to make changes when generating a tile, grout or paint report, and in CAD 

Kitchens and CAD Decor PRO, under the ,,Summery” icon. 

Illustration 37 Search for an image file containing the studio logo. 

Illustration 39 Studio data completed in options 
Illustration 38 " Studio Details"  tab in the project options window 
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In the center of the screen is the drawing space. By default, the background is black (Illustration 41), but you can change it to white 

(Illustration 42) by selecting "View" from the top menu, followed by "Display Options" and "White Background". With a white background, the 

line grid displayed by default can make things difficult, but you can customize how the grid is displayed to your preference, as described in 

section 7.3. .  

There are two types of menus at the top of the screen: top, which are the options "File", "View" "Draw", "Interior", "Documentation", 

"Dimensions", "Modify", "Tools" and "Help", shown below, and the iconic, or movable, toolbars containing thematically grouped functions, 

shown in section 5.1. Lower still is the "Entity Properties" bar (described in section 5.4). At the 

bottom of the screen are the movable command bar (Command Bar, described in section 7.1) 

and the Model and Layout tab bar (described in section 7.2), and the status bar (Status Bar, 

described in section 7.3). 

In the 64-bit version, you can choose the appearance of the program window from 

several prepared themes. Themes change the colours and small details in the appearance of the 

window. To change a theme, enter Options by typing the SETTINGS  command in the command 

bar and confirming it with the ENTER  button, and then select the „Display " tab (Illustration 43). 

In the section called Application Window you can select a theme from a drop-down list with 12 

suggestions. You can also check the "Grayscale Buttons" checkbox in the same section for a 

more minimalist look. 

In the 64 bit version of the program (CAD Decor PRO 4.0, CAD Decor 4.0, CAD Kitchens 8.0), you can also open " Tools Palettes ", 

containing additional commands for editing and managing the drawing. You can read more about this functionality in .section 6.  

  

Illustration 40 The .4CAD environment window with the Wall Wizard window open 

Illustration 42 The appearance of the environment after inserting walls and changing the background color to white 

Illustration 41 Selecting a program theme in the Options window 

on the Display tab 

Właściwości_obiektu#_Pasek_
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5.1. Top menu functions 

The menu bar at the top of the screen includes the following options.: 

File 

(Illustration 44) 

The drop-down menu contains commands related to project operation. It enables the creation of a new 

project or opening an existing one, saving changes to a project, saving a project under a new name, exporting 

a project to an XML, JPG or PDF file, terminating work with a project or program, printing the current view or 

editing project data options (and studio data). If this menu is invoked after a project is closed, there are only 

three options available: creating a project, opening a project and ending work with the program. 

 

View 

(Illustration 45) 

The drop-down menu contains commands related to design display options. It allows you to change the 

magnification or viewing direction, display the entire drawing or the previous view, zoom in on the selected 

section (zoom to window), and pan and refresh the view. Additionally, it enables you to display a quick 

preview of the design in 3D and enter visualization mode. 

 

Draw 

(Illustration 46) 

The drop-down menu contains tools for drawing, such as path, line, arc, rectangle, and circle, as well as 

options for creating and editing text. 

Illustration 43 Top menu options - the "File" menu when a project is open 

Illustration 44 Options for the top menu of the .4CAD environment, the "View" menu 
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Interiors 

(Illustration 47) 

The drop-down menu contains options for creating interiors, grouped into sections for creating rooms, 

inserting and converting 3D models, creating kitchens and closets, and editing and hiding elements. 

 

Documentation 

(Illustration 48) 
The panel contains options relating to documentation, quotations, price lists and their management. 

 

Dimensions 

(Illustration 49) 

This is a drop-down menu that includes options for object dimensioning. It corresponds to the icon menu bar 

with the same name. 

Illustration 45 Top menu options, "Draw" menu 

Illustration 46 Top menu options, "Interior" menu 

Illustration 47 Top menu options, "Documentation" menu 
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Modify 

(Illustration 50) 

The drop-down menu includes options for performing operations on elements, such as grouping, copying, 

repositioning, and other transformations that are performed on objects. 

 

Tools 

(Illustration 51) 

The menu includes options for layer handling, object snapping, object location (distance and point 

coordinates), calculations (field and calculator), and object information. Additionally, there are settings for 

drawing. 

 

Help 

(Illustration 52) 

The drop-down menu contains functions to call the IntelliCAD 10.1 help window, activation code entry 

window, or .4CAD information window (Illustration 53). 

 

Illustration 48 Top menu options, "Dimensions" menu 

Illustration 49 Top menu options, "Modify" menu 

Illustration 50 Top menu options, "Tools" menu 

Illustration 51 Top menu options, "Help" menu 
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5.2.  Managing the icon menu in the .4CAD environment 

The Icon menu is a helpful feature of the program, enabling users to execute commands with ease using the mouse. To identify the function 

of a specific icon, simply hover the cursor over it (without clicking) and a label with the function name will appear. The subsequent section displays all 

available icons. 

The icon menu is typically located at the top of the screen, below the top menu. However, it can be moved and hidden to suit personal 

preferences and enhance the user experience of the program. To move the icon bar, left-click on the 'perforated' line made up of dots 

(Illustration 54) and then, while holding down the button, drag the bar to the desired location. Release the button when you reach the desired 

position. To minimize screen space, place the bars side by side in their designated positions: either under the top menu or on the sides of the 

screen. This is especially useful when working with a widescreen monitor. 

Moving the icon bar into the design area will cause a cross to appear in its upper right-hand corner 

(Illustration 55). If the bar is not needed at the moment, it can be closed. To reopen a closed bar, right-click in 

the grey area at the top edge of the screen to open a context menu (Illustration 55). Locate the name of the 

closed bar (it does not have the  sign) and left-click on it. The bar will reappear on the screen.  

The context menu can be used to disable the command bar and status bar by unchecking their positions. The 'Palette Tools' can also be 

enabled or disabled (see section 6). The top menu can be customized by selecting the 'Show Menu' option and deselecting the items to be hidden 

(Illustration 56). 

  

Illustration 52 Information about the CAD environment 

Illustration 53 "Tools" bar, highlighted line for 

moving 

Illustration 55 Toolbar management 

Illustration 54 Manage the visibility of top menu items 
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5.3. Functions of the Icon Menu in the .4CAD Environment 

The icon menu in CAD Decor PRO and CAD Kitchens appears identical. However, there are differences between this menu and the one 

available in CAD Decor, which are illustrated on the next page (Illustration 57 and 58). The toolbars and icons within them are presented below, 

arranged according to their layout in CAD Decor PRO and CAD Kitchens. Any icons and functions that are not available in CAD Decor are marked 

with a '*'. 

 

 

 

Toolbar  
Standard 

 New Starting a new project / DWG drawing. 

 Open Open a project or DWG drawing saved on disk. 

 Save Saving the current project / DWG drawing. 

 Print… Printing DWG designs/drawings. 

 Help Display of IntelliCAD 10.1 help (also available under the keyboard shortcut F1). 

 

Toolbar  
Modify 

 Move Moving the object based on the two points indicated in the design. 

 Moving… Moving an object by a set distance along a selected axis. 

 Rotate Rotate the item based on the indicated point and angle. 

 Rotating… Rotate an object based on the selected coordinate axis.  

 Copy Copying an object any number of times and inserting it in the indicated location. 

 Mirror Mirror the object based on the indicated plane. 

 Offset Create copies with parallel offset from the original. 

Illustration 56  Icon menu toolbars in CAD Decor PRO and CAD Kitchens 

Illustration 57  Icon menu toolbars in CAD Decor 
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 Trim  Removing parts of figures cut by other figures. 

 Explode Exploding objects into their component parts. 

 Delete Deleting selected objects. 

 Undo Undoing the last operation performed. 

 Redo Renewing the last withdrawn operation. 

    

Toolbar  
Zoom 

 Regen Refresh the project image. 

 Zoom Extents Showing the entire project. 

 Zoom Windows    Zoom in on the section of the project marked with the area. 

 Zoom In Zoom in on the project image. 

 Zoom out Reducing the project image. 

 Zoom Previous Return to the previous view of the interior 

 Real-Time Pan Image shift. 

    

Toolbar   
Visualisation 

 Save interior Saving the interior to disk. 

 Load interior Loading a interior from disk. 

 Visualisation Transition to visualization. 

    

Toolbar  
View 

 Top Setting up a vertical top view of the project. 

 Front Setting the front view of the project. 

 Right Side Set the project view to the right. 

 Left Side Setting the project view from the left. 

 Back Setting the rear view of the project. 

 Aerial, Left Front Set up the axonometric view of the project from above, left, and front. 

 Aerial, Right front Setting up the top, right, and front axonometric views of the project. 

 Aerial, Right Rear Setting up a top, right and rear axonometric view of the project. 

 Aerial, Left Rear Setting up the top, left and rear axonometric view of the project. 
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Toolbar 
Tools 

 Distance Reading the distance between two points. 

 Area Reading the area of an object. 

 Point Coordinates Reading the coordinates of the indicated point on the object. 

 List Entity Info Displaying information about the object. 

 Calculator Running the Windows calculator. 

    

Toolbar  
Interior 1 

 Walls Several ways to draw the walls of a interior. 

 Doors and windows Inserting doors and windows into the project. 

 Cabinets* Inserting kitchen furniture from the selected base. 

 Worktops* Generating Type worktops. 

 Untypical worktops* Generating non Untypical worktops. 

 Documentation for 
worktops* 

Create and edit technical drawings of worktops. 

 Posts Drawing posts and arc walls with given parameters. 

 Cabinet trim* Generate or draw cabinet trim  and create custom profiles. 

 Home appliances * Insert household appliances from manufacturers' databases. 

 Valuation* Generate a quote for the cabinet set. 

 Valuation manager* Switching between alternative valuations. 

 Price list* Manufacturer's price list for kitchen cabinet bases. 

 Visibility Revealing or hiding selected object classes. 

 Define set* Swapping patterns, colours, and handles, etc.. 

 Edit* Edit the selected cabinet from the currently used kitchen base. 

 Documentation Generate technical documentation for the project. 

 Cabinet Editor* Open Kitchen Cabinet Database Editor and User Cabinet Editor. 

    

Toolbar  
Interior 2 

 Free-formed objects Drawing floors, enclosures, platforms, plinths and ceilings of any shape, as well as 3D 
text and solids from faces. 

 Build-in wardrobes Opening the module for designing, editing and pricing wardrobes and shelving’s. 

 Converter Convert 3D models in various formats to DWX. 
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 Interior items Insert 3D models from Interior databases. 

 Interior items 
valuation 

Provide a quotation for the equipment required for the project. 

    

Toolbar  
Draw 

 Polyline Drawing a path from a polyline. 

 Line Drawing a straight line. 

 Arc Drawing the arc. 

 Rectangle Drawing a rectangle (or square). 

 Circle Drawing a circle. 

 Text Inserting 2D text into the design. 

 Edit text Editing the 2D text you entered. 

 Insert block form file Insert a block from the indicated location on the computer disk. 

    

Toolbar  
Entity snaps 

 End point Attract the cursor to the endpoint of the indicated object.. 

 Nearest Attract the cursor to the nearest point of the indicated object. 

 Midpoint Attract the cursor to the midpoint of the indicated object, such as the center of a 
segment. 

 Central point Attract the cursor to the centre point of the indicated arc circle. 

 Perpendicular Attract the cursor to a point at a right angle. 

 Quadrant Attract the cursor to the nearest quadrant of the circle. 

 Insertion point Attract the cursor to the insertion point (base point) of another object. 

 Point Attract the cursor to a selected point. 

 Intersection point Attract the cursor to the intersection of two elements, such as two lines or arcs. 

 None 
(Inactive attraction) 

Disable all points of attraction. 

    

Pasek 
Dimensioning 

 Linear Drawing the dimension in a straight line (vertically or horizontally). 

 Aligned Drawing a dimension from any angle. 

 Angular Drawing the dimension of the angle between the lines. 

 Diameter Dimensioning the diameter of a circle or arc. 
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 Radius Dimensioning the radius of a circle or arc. 

 Baseline Drawing dimension lines in the form of a base string. 

 Continue Drawing dimension lines in the form of a serial chain. 

 Edit Dimension Text Quickly modify the descriptions of selected dimension lines. 

 Dimension Style 
Manager 

Modify dimensioning style (lines, arrows). 

 Apply Style Application of new style for selected dimension lines. 

5.4. The "Entity Properties" bar under the icon menu 

You will find another set of tools in the "Entity Properties" toolbar, located under the icon menu (Illustration 59). The CAD environment 

offers a set of advanced functions for managing layer properties. 

  

  

 

The visibility, colour, line type, and thickness of the layers can be managed. Additionally, the layers can be turned on and off, which makes 

them invisible in the project and on the printout, but they can still be edited and affect the display and printout of visible layers. The layers can also 

be freeze and thaw, which makes them invisible in the project and on the printout, and they cannot be edited or obscure other layers. The only 

Illustration 59 Selected object belonging to the TECHNICAL_T layer Illustration 60 Selected object belonging to the POLYLINE_T layer 

Illustration 61 Selected object belonging to the RESTA-3D layer Illustration  62 Selected object belonging to layer PODESTY-3D 

NOTE 

In the .4CAD environment, layers correspond to the transparent decals used in traditional manual drawing. They help to organize 

and structure your illustration, which is especially important for complex projects. Each element drawn in the .4CAD environment is 

assigned to a layer with a specific function (Illustration 60-Illustration 63).   Individual parts of 3D models can be drawn on different layers, 

allowing for different properties to be assigned to them in the visualization. The element being drawn is assigned to the current layer, and 

users can create new layers for their own objects.  It is recommended to avoid using the default software layers for personal objects and 

not to change the software layers for assigned objects.   

Illustration 58 " The "Entity Properties" bar 
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layer that cannot be frozen is the current layer. Additionally, layers can be locked and unlocked using the lock/unlock feature. When a layer is 

locked, it remains visible but cannot be edited, which helps prevent accidental modifications to the drawing. 

Modifications to the selected element's layer settings can be made on the fly using the " Entity Properties" bar, while changes to the 

properties of all layers are made in "Layer Explorer". When you click on an element with the left mouse button, the first field of the "Entity 

Properties" bar will display information about which layer it is currently assigned to. The available functions are described below.  

 Set Leyer by Entity Change the current layer to match the layer of the indicated object. 

 Explore Layer Opens the "Layer Explorer" (Illustration 64) window, where you can modify all the attributes of the 

layers in the project.  

 

 Layer change field Allows you to assign a drawn element to a layer selected 

from the drop-down list. 

 

 

Color change field Allows you to change the color of the layers: select the object and 

choose a color from the drop-down list (Illustration 65) or define your 

own by clicking the "Select Color..." item (this will then open a new 

"Color" window with three tabs, shown in the following illustrations 

(Illustration from 65 to 68). 

 

NOTE 

It is not recommended to make changes to the default program layers as this could have serious consequences. Doing so would 

cause the program to no longer recognize a given object as its intended class, resulting in the loss of options assigned to that class of 

objects. For example, a cabinet would no longer be recognized as a cabinet and a wall would no longer be recognized as a wall. 

Illustration 63 Layer explorer window 

Illustration 64 Color change field - expanded list of colours 
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 Line type change field Allows you to change the line type of an object. There are 

different styles to choose from (Illustration 69). 

 

 Field for changing the width of 

the line 

Allows you to change the width of a line, such as to 

increase visibility on a printout or to meet technical 

drawing standards. 

UWAGA  

The program has line width display enabled by default. This function can be enabled or disabled in two ways. The first way is to 

select 'Drawing Settings' from the 'Tools' menu in the top menu.  In the newly opened Drawing Settings window, go to the 'Display' 

tab and select the options under 'Lineweights'. There is a 'Display Lineweights’ checkbox that can be checked or unchecked 

(Illustration 70). The second way is to use the 'On/Off line width' icon on the status bar. (See section 7.3) 

Illustration 69  Expanded list of line type 

Illustration 68  Manage the line width display in the Drawing Settings window 

Illustration 65 Layer color selection 

window - Index Color tab 
Illustration 66 Layer color selection window 

- True Color tab 

Illustration 67- Layer color selection window - Color 

Books tab 
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6.     Tools Palettes in dot4CAD 10.1 

In the 64-bit environment of dot4CAD 10.1, a new way of accessing some existing tools and functions previously unavailable in the main 

or icon menu of the program has been introduced. We are talking about the " Tools Palettes " located by default on the right side of the screen 

(Illustration 71). 

By combining the concepts of toolbars and ribbons, Tools Palettes enable quick access to drawing tools, object modification, and view 

changes. The following sections discuss the various palettes. 

  

Illustration 70 Program window with Tools Palettes enabled 
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Illustration73 View palette at Tools Palettes 

 
 

 

 

 

 

  

Illustration 74  3D Orbit palette at Tools Palettes Illustration 75  Draw Order palette in Tools Palettes 

Illustration 71 Modify palette in Tools Palettes Illustration 72 Palette Inquiry in Tools Palettes 
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,,Modify" palette (Illustration 72) 

This palette contains tools, related to object modification, such as in the Modify toolbar (see section 5.3) and additional tools: Clone, Scale, 

Mirror3D, Rectangular Array, Polar Array, Path  Array, Array Edit, Break, Join, Flatten, Align, Extend, Edit Length, Stretch, Fillet, Chamfer, Edit 

Polyline, Edit Spline, Edit Text..., Xplode Change, Change Space. 

By moving and holding the cursor over the icon of a particular function, you can display a hint describing how it works. 

 Move Moves the selection. 

 Copy Draws one or more duplicates of the selected object. 

 Clone Create a new object by selecting an existing one. 

 Offset Copies a selection passing through a point or at the specified distance. 

 Scale Resizes the selection, preserving the proportions. 

 Delete Deletes the selection. 

 Rotate Rotates the selection relative to a point. 

 3D Rotate Rotates the selection relative to the axis. 

 Mirror Mirroring relative to the axis. 

 3D Mirror Creates a mirror image of an object relative to a plane. 

 Rectangular Array Creates copies of objects in an array with a specified combination of columns and rows. 

 Polar Array Creates copies of objects in a circular array around a central point. 

 Path Array Creates copies of objects evenly in an array along a path or part of a path. 

 Array Edit Edits objects in the array and source objects. 

 Break Interrupts a linear object at a specific point. 

 Join Combines collinear objects into one.. 

 Trim Cuts off parts of the selection using other objects as a form. 

 Flatten Sets the selection level and changes the thickness to zero. 

 Align Matches the selected object with other objects. 

 Extend Extends the selection until it intersects with the specified object. 

 Edit length Edits the length of the selection. 

 Stretch Stretches or displaces the selection without breaking the connections. 

 Filletj The smooth arc connects the sides after breaking the corner.. 

 Chamfer The angled line connects the sides, breaking the corner. 

 Edit Polyline Edits the properties of the polyline. 

 Edit Spline Edit a spline or polyline that is fitted into a spline (smooth curve passing through a sequence 

of indicated points). 

 Edit Text… Edits the content of text objects. 
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 Explode Separates complex objects into the next, simpler level of components. 

 Xplode Separates a compound object into its components. 

 Change Changes the properties of the selection, including height. 

 Change Space Converts selected objects to a different area. 

 

Palette "Inquiry" (Illustration 73) 

This palette contains tools related to obtaining information about project elements and working with variables. Some of the same as in the 

Modify toolbar and additional tools.  

By moving and holding the cursor over the icon of a particular function, you can display a hint describing how it works. 

 Distance Calculates the distance between two points. 

 Area Calculates the area inside a closed object. 

 Mass Properties Calculates and displays mass properties of regions or solids. 

 ID Coordinates Specifies the X, Y and Z coordinates of the selected point. 

 List Entity Info Displays information about the selected object. 

 Variable Setting Specifies the value of the variable, which can then be changed as needed. 

 Drawing Status Lists the current status of the drawing. 

 Time Variables Lists information about time-related variables. 

 

Palette "View" (Illustration 74) 

This palette contains tools, related to view management, perspective changes and camera control. Tools like those in the View toolbar are 

present here (see section 5.3) and additional tools. 

By moving and holding the cursor over the icon of a particular function, you can display a hint describing how it works. 

 View Manager Displays the View Manager window. 

 Dynamic view control… Brings up the real-time observation point control dialogue box. 

 Present viewpoints… Opens the Present Viewpoints dialog box. 

 Plan view Shows the top view of the specified local coordinate system. 

 Create Camera Creates a camera view in the model area. 

 Top Top view. 

 Front Front view. 

 Right Side View from the right. 

 Left Side View from the left. 

 Back Back view. 

 Bottom Bottom view. 

 Aerial, Left Front Top view from left front. 
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 Aerial,, Right Front Top view from right front. 

 Aerial, Rght Rear Top view from the right rear side. 

 Aerial,, Left Rear Top view from the left rear. 

 Aerial, Left Front Bottom view from the front left. 

 Aerial, Right Front Bottom view from right front. 

 Aerial, Right Rear Bottom view from the right rear side. 

 Aerial,, Left Rear Bottom view from left rear. 

   

"3D Orbit" palette (Illustration 75) 

This palette contains tools, related to rotating objects in 3D. 

By moving and holding the cursor over the icon of a particular function, you can display a hint describing how it works 

 Constrained Orbit Rotates the view in a three-dimensional orbit bounded horizontally and vertically. 

 Free Orbit Rotates view in free 3d orbit without limiting rotation. 

 Continuous Orbit Rotates 3D view with continuous motion. 

 Real-Time X Real-time cylindrical X rotation. 

 Real-Time Y Real-time cylindrical Y rotation. 

 Real-Time Z Real-time cylindrical Z rotation. 

   

Palette "Draw Order" (Illustration 76) 

This palette contains tools, related to determining the order in which elements are displayed in the drawing. 

By moving and holding the cursor over the icon of a particular function, you can display a hint describing how it works 

 Front Change the display order of objects to be on the front. 

 Back Change the display order of objects to be at the back. 

 Above Change objects to be above the selected object. 

 Under Change objects to be below the selected object. 

 Send Hatches Back Change the order of the hatching display to be on the back side. 

 Bring Text Front Change the order of text display to be on top. 

 Bring Leaders Front Change the display order of the reference lines to be on top. 

 Bring Dimensions Front Change the order in which the dimensions are displayed so that they are on top. 

 Bring All Annotations Front Change the display order of all description objects to be on top. Change the display order of 

all description objects to be on top. 
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You can enable or disable the Palette Tools by right-clicking (PPM) in the grey area at the top edge of the screen -> a context menu will 

expand (Illustration 55), in which you should find the name "Tool Palettes" and left-click (LPM). Enabling Tool Palettes means that a checkmark 

appears next to the name.. Palette tools can be minimized using the "_" button or closed using the "x" button. 

7. dot4CAD Toolbars 

These are elements of the .4CAD environment that make working with the project easier. The first, Command Bar is used to issue 

commands to the program using the keyboard, as well as to display prompts to the user. The second tabbed bar, Model and Layout allow you to 

switch between a 3D drawing and a 2D projection and create new tabs, while the third Status Bar,-displays information about the position of the 

cursor and allows you to change various drawing settings. The functions available in them and how to manage them are described in the following 

subsections. 

7.1. Command Bar 

It is used to enter keyboard commands and read program prompts. When working with the project, look for and follow the notations 

that appear in it. These include hints on the next steps of the selected function, command prompts when typing, and keyboard shortcut prompts, 

which are shown in blue. The command bar can be moved, closed and opened, just like the toolbars. 

It can also be freely stretched (its size depends on the DPI). To change the position of the toolbar, use the drag-and-drop method, i.e. 

click with the left mouse button on its grey frame on the left of the screen, hold down the button and move the mouse, releasing the button when 

you have reached the desired position. To stretch the bar, place the cursor on its edge and when the double-headed arrow appears, click on it 

with the left mouse button and move the mouse in the desired direction, keeping the button pressed. Below is the command bar when stationary 

in its default position at the bottom of the screen (Illustration 77) and when moved up, below the toolbar (Illustration 76). 

 

Illustration 76 Indication of possible docking locations when Standard docking style is selected 

Illustration 77 Default position of the command bar at the bottom of the screen 
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Right-clicking the Command bar brings up a shortcut menu where you can select 'Standard Docking Style'. If you enable this, arrows will 

appear on the screen as you move the toolbar, suggesting where to dock it ((Illustration 78). You can also move the toolbar around the drawing 

area without docking it to a specific edge. 

7.2. Model and Layout tab  

In this bar, located at the bottom edge of the screen, directly below the drawing area, by default there are "Layout1" and "Model" tabs. 

By default, the "Model" tab is active. The first displays a two-dimensional sheet (Layout), the equivalent of a sheet of paper, on which you can 

create model viewports, for example, to represent a detail. The second, displays the three-dimensional space in which the model is created (e.g., 

a piece of equipment or a room design). The name of the currently used tab is displayed in bold (Illustration 79). You can add new sheets, give 

them their own names and move them right or left, as well as delete them (Illustration 80). This is the only toolbar of the .4CAD environment that 

cannot be hidden. You can read more about the use of sheets and the creation of viewports in the IntelliCAD Help under [F1]. 

Two pop-up menus under the right mouse button are available for the model/sheets switching bar. If you click on the Model tab, the 

menu, shown below (Illustration 81), unfolds. On the other hand, by double-clicking with the left mouse button in the grey space of the bar, the 

name of the layout can be changed.  

When you right-click the Layout tab, an expanded menu appears. 

 

Illustration 78 Command bar docked under icon menu, Standard docking style option checked 

Illustration 79 Model and Layout tool bar 
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7.3. Status Bar 

This is a grey bar at the bottom of the screen, showing cursor coordinates, the name of the current layer and information, regarding 

selected IntelliCAD commands and tools. To hide or expose the items displayed on the Status Bar, right-click on an empty space of the bar - a 

context menu will expand, where you can add or remove a check mark next to the selected items (Illustration 82). The entire Status Bar can be 

hidden by using the menu mentioned in the box above to control the visibility of IntelliCAD's bars, accessible from the command bar and the 

model and sheet tab toggle bar. 

 

Below is a description of each field in the status bar. For ease of reference, they are shown in the illustrations with consecutive numbers 

in orange: 

Illustration 80 Adding a new tab 

Illustration 81 Menu Layout 

Illustration 82 Status bar menu 

Illustration 83  Status bar and context menu 
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 1. Drawing Coordinates (in the X, Y, Z axes) determines the position of the cursor (the entry shown in the default status bar view) 

(Illustration 81). If you right-click, you can select the type of units.  

2. XOR Cursor On/Off -.activation and deactivation of the XOR cursor display option. 

3. Gun Sight Crosshairs On/Off – determines how the cursor is displayed in the program.  

4. Annotation Scales List – Allows you to set the scale. The program has a built-in list of scales. You can add your own or modify the 

currently existing one. 

5. Annotation  Visibility On/Off– option concerning the display of descriptions in the program.  

6. Automatic Annotation On/Off – option concerning the display of descriptions in the program. 

7. Snap On/Off - Snap options - By default, drawing is done in one-unit increments. To enable or disable this function, double-click on 

the snap options. This option is visible in standard view.). 

8. Grid On/Off - The reference grid is set with points 500 mm apart by default. You can turn the grid's visibility on or off by clicking the 

left mouse button (LPM), and access its settings by clicking the right mouse button (Illustration 84). An option is visible in the default status bar 

view. 

9. W Dynamic Input on/Off – – Activates or deactivates the dynamic input option in the program. 

10. Orthogonal – activates/deactivates options, this is one of the options for entering coordinates. 

Illustration 84  Settings of the Grid in the program 
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11. Polar Tracking On/Off  - one option from the coordinate input, right-clicking shows more options (Illustration 85 and Illustration 86). 

12. Entity Snap Settings– snap option settings. 

13. Entity Snap Tracking On/Off- activates or deactivates the option to snap objects. When you right-click, you can select one of the 

options. 

14. Lineweight on/Off – possibility to activate/deactivate the line, when you 

click the right mouse button, more options are shown.  

15. Model or Paper Space– switching between Model and Layout tabs. 

16.  Tablet On/Off - enabling the drawing tablet reader. Option visible in the 

default status bar view. 

17. Switch between Workspaces– the ability to move between workspaces. 

18. Digital Signature Status- the ability to add an electronic signature, to open 

the window, click on the icon using the left mouse button. 

Illustration 86 Polar Tracking settings 
Illustration 85 Options Polar Tracking. 

Illustration 87 Snap options 

Illustration 88 Option to change line width 
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19. Clear screen on/Off– organizes the program screen, allows you to hide the icons of the top menu and the Model/Layout bar. 

20. Show Window Menu– displays menus and allows personalization 

of the status bar view (Illustration 90). 

21. Switch Graphics Device– option to select graphics devices. 

  

Illustration 89 Digital Signature 

Illustration 90 Customization options for the status bar 
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8. Additional information 

8.1. Instructional videos  

• Launching the program and completing registration codes 

• Project management - adding projects from outside  

• Setting autosave and project recovery  

• Export / import of projects  

• My first project - THE SITUATION ROOM  

• My first project - BATHROOM  

• My first project - KUCHNIA 

• New CAD environment 64 bit in CAD Decor PRO 4 0, CAD Decor 4 0, CAD Kitchens 8 0  

8.2. Keyboard shortcuts   

The document compares keyboard shortcuts in the .4CAD and visualization environments and lists the most frequently used commands 

in versions up to 3.Xi/7.X and version 4.X/8.X (both 34 and 64 bit versions of the environment).  Find the document at:  :   

https://www.cadprojekt.com.pl/zasoby/pdf/opisy-techniczne/shortcuts-4-0-8-0-eng.pdf  

 

This document provides an overview of keyboard shortcuts and commonly used commands in the .4CAD environment for visualization. 

The shortcuts and commands can be issued using either the mouse or keyboard. It can be accessed at:    

https://www.cadprojekt.com.pl/zasoby/pdf/opisy-techniczne/shortcuts-4-0-8-0-64bit-eng.pdf 

 

In the above list, LPM and RMB stand for left and right mouse buttons, respectively. A command notation with a + sign (e.g. [Ctrl] + [Z]) 

indicates that both keys should be pressed simultaneously, while a notation with a >> symbol (e.g. [E] >> [Enter] or [Space]) means that you should 

first type E and then press [Enter] or the space bar. 

 

  

https://www.youtube.com/watch?v=x2K7oo7jFZc&list=PLSZETRAJpDRajPLT1hhvbboUGYI17lYjO&index=9
https://www.youtube.com/watch?v=Ex0D_GA4EjE&list=PLSZETRAJpDRajPLT1hhvbboUGYI17lYjO&index=15
https://www.youtube.com/watch?v=rMe18bBYHdo&list=PLSZETRAJpDRajPLT1hhvbboUGYI17lYjO&index=12
https://www.youtube.com/watch?v=d_Fie-VKHog&list=PLSZETRAJpDRajPLT1hhvbboUGYI17lYjO&index=11
https://www.youtube.com/watch?v=su7pNVEjMyY&list=PLSZETRAJpDRajPLT1hhvbboUGYI17lYjO&index=8
https://www.youtube.com/watch?v=VkPp26uPjOo&list=PLSZETRAJpDRajPLT1hhvbboUGYI17lYjO&index=7
https://www.youtube.com/watch?v=5dziLgW0xlo&list=PLSZETRAJpDRajPLT1hhvbboUGYI17lYjO&index=6
https://www.youtube.com/watch?v=ISnThJysP4A&list=PLSZETRAJpDRZUOxYmEPz2hZFm-oBSkA4q&index=3
https://www.cadprojekt.com.pl/zasoby/pdf/opisy-techniczne/shortcuts-4-0-8-0-eng.pdf
https://www.cadprojekt.com.pl/zasoby/pdf/opisy-techniczne/shortcuts-4-0-8-0-eng.pdf
https://www.cadprojekt.com.pl/zasoby/pdf/opisy-techniczne/shortcuts-4-0-8-0-64bit-eng.pdf
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Technical support 

Mon-Fri from 8 a.m. to 5 p.m. 

pomoc@cadprojekt.com.pl 

tel. +48 61 662 38 83 

 

Contact form 

 

 

 

 

 

 

 

We would like to inform you that we provide training in the use of our programs. For more information, please visit our website: 
https://www.en.cadprojekt.com.pl/trainings/  

 

Training section 

szkolenia@cadprojekt.com.pl 

tel. +48 505 138 863 

 

 

 

 

 

 

 

 

 

http://cadservice.cadprojekt.com.pl/?lang=en
https://www.en.cadprojekt.com.pl/trainings/

